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                                                                                1 Thank you for choosing PDF Creator Plus! PDF Creator Plus 6.0 has been successfully installed on your computer: the PDF Creator Plus preview application is now available from the shortcut placed on your desktop the PDF Creator Plus 6.0 printer is now available from your printers list. Getting Started How do I create a PDF using PDF Creator Plus? How do I create a PDF with hyperlinks and outline information? How can I merge my documents into a single PDF? page to page or to re-arrange the pages by clicking and dragging the thumbnail image within the view. 2. The currently selected page is displayed in the Page view. 3. The annotation toolbar can be used to add text boxes and hyperlinks, and shape objects such as lines or circles. 4. The three most common file formats are available from the Create PDF, Create TIFF and Create JPEG buttons in the blue Task view at the top of the application. 3. CREATE PDF Click the Create PDF button in the blue task view to From the Create File dialog you can choose the type of PDF file to create and where on your computer to save your PDF file. CREATING A PDF USING PDF CREATOR PLUS Creating a PDF using PDF Creator Plus is a simple, 3-step process : Print your document, Preview your pages, and then Create your PDF. 1. PRINT Select the Print option from your application s menu, choose the PDF Creator Plus 6.0 printer from the Print dialog and press OK to start. 2. PREVIEW YOUR PAGES 3. Output options, such as Embedded Fonts, Include Hyperlinks, Security, Initial View and Page Layout can also be configured. 1. The Thumbnails view shows a small image of each page. You can use this view to move from 1
                                                    
                                                    
                                                    
                                                    

2 CREATING A PDF WITH HYPERLINKS PDF Creator Plus includes a Microsoft Word Add-In that allows you to create PDF documents from Microsoft Word and keep the hyperlinks, bookmarks and any table of contents information. When you are satisfied with the settings, click the OK button to start the Save As PDF 6.0 process. Instead of printing the Word document to the PDF Creator Plus 6.0 printer, the document must be sent to PDF Creator Plus using the Save As PDF Add-In in order to transfer the hyperlink, bookmark and table of contents information from Word. 1. FINDING THE ADD-IN In Microsoft Word 2007, 2010 and 2013, the toolbars are now replaced with a tabbed ribbon. The Save As PDF 6.0 Add-In is located on the Add-Ins tab of the ribbon. On versions of Microsoft Word prior to 2007, the Save As PDF 6.0 Add-In creates a new menu item, Save As PDF, under the File menu, as well as creating a new custom Save As PDF 6.0 toolbar. A progress dialog displays feedback on what step of the process is currently being done. You will see different parts of the document being selected as the Save As PDF 6.0 Add-In moves through the document and processes each page. 3. PREVIEW YOUR PAGES When finished, the PDF Creator Plus application will launch and display the document as a new project. Any document styles that were assigned an outline level will be displayed in the Outline tab of the Navigation view. 2. RUNNING THE ADD-IN The Save As PDF 6.0 Add-In launches the PDF Bookmark Creation Settings dialog which allows you to customize the outline of your PDF file. The outline information in PDF Creator Plus is used to create the Bookmarks tab in Adobe. From this dialog, choose what outline level, from 1 to 9, to assign each available style in the document. By default, the styles Heading 1, Header 2 and Heading 3, if they are used in the document, are already assigned as Outline Levels 1, 2 and 3. Any text in the document with a style that has an assigned outline level will be included as a bookmark in the PDF when it is created. Changes made here are only used during the Save As PDF 6.0 Add-In process. They do not affect the current styles and formatting in the document. 2
                                                    

3 4. CREATE YOUR PDF Click the Create PDF button in the blue Task view area to The PDF created will have the same hyperlinks, bookmarks and any table of contents information as the original Word document. MERGING DOCUMENTS INTO A SINGLE PDF PDF Creator Plus makes it easy to merge files of different formats together into a single PDF file. Want to include maps and directions from the internet with your travel itinerary? Want to add an Excel spreadsheet to the end of a report from an in-house application? With PDF Creator Plus it s easy! 1. PRINT THE FIRST DOCUMENT Open your first document and select the Print option from your application s menu. Choose the PDF Creator Plus 6.0 printer from the Print dialog and press OK to send the document to PDF Creator Plus. 2. PREVIEW THE PAGES 3. Different output options, such as Embedded Fonts, Include Hyperlinks, Security, Initial View and Page Layout can also be configured. Make sure to leave the Include Outline and Include Hyperlinks options checked to create hyperlink information in your PDF file. The PDF Creator Plus preview application will automatically open and display the pages you printed. Leave the preview application open and continue printing the other documents. 3
                                                    

4 3. CONTINUE PRINTING For each other document printed to the PDF Creator Plus 6.0 printer, the preview application will display a prompt asking where to add the new pages. The default action is to Append the new pages to the end of the project; if desired you can insert the pages at any point in the current list of pages. 4. CREATE YOUR PDF When you have combined all the documents you want together in the preview application, click the Create PDF button in the blue Task view to 3. Output options, such as Embedded Fonts, Include Hyperlinks, Security, Initial View and Page Layout can also be configured. If you have used the Microsoft Word Save As PDF 6.0 Add- In to send outline and hyperlink information, make sure to leave the Include Outline and Include Hyperlinks options checked to include the hyperlink information in your PDF file. CONTACT INFORMATION Please contact us for more information, comments or feedback. Hours: Sales: Support: Phone: Monday to Friday, 09h00 17h00 EST peernet@peernet.com support@peernet.com (North America only) (outside North America) Fax:
5 COMMON QUESTIONS What applications work with PDF Creator Plus 6.0? Any Microsoft Windows application that supports printing will work with the PDF Creator Plus application - just choose the PDF Creator Plus 6.0 printer from the Print dialog of your application. This will not create a paper copy of your document - a digital copy is instead sent to PDF Creator Plus. From within PDF Creator Plus you can then create PDF documents, or TIFF or JPEG images of your original document. Why don't I get any hyperlinks or outline information in my PDF document? Hyperlinks can only be retained from Microsoft Word documents when using the Save As PDF 6.0 Add-In. See Creating a PDF with Hyperlinks for step-by-step instructions. If you have used the Save As PDF 6.0 Add-In to send your Word document to PDF Creator Plus, you also need to have the Include Outline and Include Hyperlinks options checked in the Create File dialog when creating your PDF file. Still have questions? Visit the PEERNET Forum to search our knowledge base of frequently asked questions, or contact the PEERNET Technical Support team with your question. 5
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        PDF Creator Plus 6.0. Version 6.0. User Guide. PEERNET Inc.
    

    
        
        Version 6.0 User Guide PEERNET Inc. Copyright 2004-2012 Updated: 12/12/2012 Table of Contents Welcome... to PDF Creator Plus 1 Legal... Notices 2 System... Requirements 3 Typographic... Conventions 4 Activating...    
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        PEERNET File Conversion Center 6.0
    

    
        
        Thank you for choosing PEERNET File Conversion Center. The PEERNET File Conversion Center integrates seamlessly with your desktop and Windows Explorer to allow you to quickly and easily convert office    
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        USER S GUIDE Software/Hardware Module: ADOBE ACROBAT 7
    

    
        
        University of Arizona Information Commons Training 1 USER S GUIDE Software/Hardware Module: ADOBE ACROBAT 7 Objective: Scan and create PDF Documents using Adobe Acrobat Software p.1 Introduction p.2 Scanning    
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        Microsoft Access 2013
    

    
        
        Microsoft Access 2013 Chapter 1 Databases and Database Objects: An Introduction Objectives Describe the features of the Access window Create a database Create tables in Datasheet and Design views Add records    
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        BASIC MICROSOFT POWERPOINT
    

    
        
        BASIC MICROSOFT POWERPOINT PART ONE PHONE: 504-838-1144 IT Training Team Jefferson Parish Library EMAIL: jpltrain@jplibrary.net In this class you will learn to: Launch, close, and interact with Microsoft    
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        This is the preferred method when combining documents that are finished and not expected to change.
    

    
        
        Combine Documents This quick reference addresses the need to combine several documents as one (i.e. CPPR). The following are ways to create a single document from several smaller Word or Excel documents.    
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        Microsoft Word Handout
    

    
        
        Microsoft Word Handout Navigating Microsoft Word Maneuvering your way through Word is the key to working efficiently on all of your documents. This guide will help you locate the necessary tools and understand    
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        SAMPLE - NOT LICENSED
    

    
        
        Bill s Getting Started Guide for pdfdocs-4 Copyright 2014 Discovery Partners, Inc. Page 1 Create a new PDF: A) From MS-WORD: Choose this option to convert your Word document to PDF format and open in pdfdocs-editor.    
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        Microsoft Word Basics. Pages 21-45
    

    
        
        Microsoft Word Basics Pages 21-45 1 Viewing a Document in Word Print Layout Shows how a document will look when it is printed. This view, which is the default, allows you to see headers and footers, columns,    
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        MS Word 2010 An Introduction
    

    
        
        MS Word 2010 An Introduction  Table of Contents The MS Word 2010 Environment... 1 The Word Window Frame... 1 The File Tab... 1 The Quick Access Toolbar... 4 To Customize the Quick Access Toolbar:... 4    
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        Microsoft Access 2010
    

    
        
        Microsoft Access 2010 Chapter 1 Databases and Database Objects: An Introduction Objectives Design a database to satisfy a collection of requirements Describe the features of the Access window Create a    
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        ABBYY FineReader 14. User s Guide ABBYY Production LLC. All rights reserved.
    

    
        
        ABBYY FineReader 14 User s Guide 2017 ABBYY Production LLC All rights reserved Information in this document is subject to change without notice and does not bear any commitment on the part of ABBYY The    
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        Word 2016 Advanced. North American Edition SAMPLE
    

    
        
        Word 2016 Advanced Word 2016 Advanced North American Edition WORD 2016 ADVANCED Page 2 2015 Cheltenham Group Pty. Ltd. All trademarks acknowledged. E&OE. No part of this document may be copied without    
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        4. In the Address Book drop-down list, click the address book that contains the  addresses you want in your distribution list.
    

    
        
        Page 1 of 5 Outlook > Contacts Create and work with a distribution list Show All A distribution list is a collection of contacts. It provides an easy way to send messages to a group of people. For example,    
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        Getting Started with Access
    

    
        
        MS Access Chapter 2 Getting Started with Access Course Guide 2 Getting Started with Access The Ribbon The strip across the top of the program window that contains groups of commands is a component of the    
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        Ms excel. The Microsoft Office Button. The Quick Access Toolbar
    

    
        
        Ms excel MS Excel is electronic spreadsheet software. In This software we can do any type of Calculation & inserting any table, data and making chart and graphs etc. the File of excel is called workbook.    

    
        More information 
    




    
        Adobe Acrobat 5.0. Overview. Internet & Technology Training Services Miami Dade County Public Schools
    

    
        
        Adobe Acrobat 5.0 Overview Internet & Technology Training Services Miami Dade County Public Schools Preparing Microsoft Office Documents in.pdf Format Converting Documents to.pdf Format Using the Tool    
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        Center for Faculty Development and Support Creating Powerful and Accessible Presentation
    

    
        
        Creating Powerful and Accessible Presentation PowerPoint 2007 Windows Tutorial Contents Create a New Document... 3 Navigate in the Normal View (default view)... 3 Input and Manipulate Text in a Slide...    
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        Introduction to Adobe Acrobat X. Ken Dickinson Bay Area Computer Training
    

    
        
        Introduction to Adobe Acrobat X Ken Dickinson Bay Area Computer Training www.bactrain.com Table of Contents What s the best way to create a PDF?... 3 Convert Microsoft Word, PowerPoint, and Excel files    
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        Microsoft PowerPoint The Microsoft PowerPoint 2000 Screen. Leander ISD Technology Services CMB Title.
    

    
        
        Microsoft PowerPoint 2007 The Microsoft PowerPoint 2007 Screen The Microsoft PowerPoint 2000 Screen Title Menu Bar Standard Formatting Toolbar Outline Pane Placeholders Slide Pane View Buttons Leander    
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        Create and print labels for a mass mailing
    

    
        
        Create and print labels for a mass mailing 1. On the Tools menu, point to Letters and Mailings, and then click Mail Merge Wizard. 2. Under Select document type, click Labels. The active document becomes    
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        Reference Services Division Presents. Excel Introductory Course
    

    
        
        Reference Services Division Presents Excel 2007 Introductory Course OBJECTIVES: Navigate Comfortably in the Excel Environment Create a basic spreadsheet Learn how to format the cells and text Apply a simple    
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        4) Study the section of a worksheet in the image below. What is the cell address of the cell containing the word "Qtr3"?
    

    
        
        Choose The Correct Answer: 1) Study the highlighted cells in the image below and identify which of the following represents the correct cell address for these cells: a) The cell reference for the selected    
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        3. Click the Change Case button. 4. On the menu, click the desired case option. Managing Document Properties
    

    
        
        PROCEDURES LESSON 20: CHANGING CASE AND MANAGING DOCUMENT PROPERTIES Using Uppercase Mode 1 Press the Caps Lock key 2 Type the desired text in all caps Showing Caps Lock on the Status Bar 1 Right-click    
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        Getting Started with Excel
    

    
        
        Getting Started with Excel Introduction Excel is a spreadsheet program that allows you to store, organize, and analyze information. In this lesson, you will learn your way around the Excel 2010 environment,    
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        Word 2010 Skills Checklist
    

    
        
        S1 S2 Sharing and Maintaining Documents 1.1 Apply different views to a document Select zoom options Split windows Arrange windows Arrange document views Switch between windows Open a document in a new    
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        Convert to PDF 3.0. User Guide. PEERNET Inc.
    

    
        
        User Guide PEERNET Inc. Copyright 2005-2013 Updated: 1/9/2013 Table of Contents Welcome... to Convert to PDF 1 Legal... Notices 2 System... Requirements 3 Activating... Convert to PDF 4 Launching the Activation    
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        Installation Guide CSA Group Reader App for Windows Desktop
    

    
        
        Installation Guide CSA Group Reader App for Windows Desktop Contents Downloading and Installing the CSA Reader App. 2 Creating an Account.... 3 Redeeming your Code. 5 Navigating the ebook.. 7 Page 1 of    
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        Microsoft Office PowerPoint 2016: Part 1. Course Overview
    

    
        
        Microsoft Office PowerPoint 2016: Part 1 Course Overview This course will introduce students to Microsoft PowerPoint 2016, as well as teach them how to develop a PowerPoint presentation, perform advanced    
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        Microsoft Word 2011 Tutorial
    

    
        
        Microsoft Word 2011 Tutorial GETTING STARTED Microsoft Word is one of the most popular word processing programs supported by both Mac and PC platforms. Microsoft Word can be used to create documents, brochures,    
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        Working with PDF s. To open a recent file on the Start screen, double click on the file name.
    

    
        
        Working with PDF s Acrobat DC Start Screen (Home Tab) When Acrobat opens, the Acrobat Start screen (Home Tab) populates displaying a list of recently opened files. The search feature on the top of the    
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        PowerPoint X. 1. The Project Gallery window with the PowerPoint presentation icon already selected. 2. Click on OK.
    

    
        
        PowerPoint X Launching PowerPointX 1. Start PowerPointX by clicking on the PowerPoint icon in the dock or finding it in the hard drive in the Applications folder under Microsoft PowerPoint. PowerPoint    
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        ADOBE 9A Adobe InDesign CS3 ACE. Download Full Version :
    

    
        
        ADOBE 9A0-055 Adobe InDesign CS3 ACE Download Full Version : http://killexams.com/pass4sure/exam-detail/9a0-055 , E QUESTION: 109 By default, which fonts are NOT included when an InDesign file is packaged?    
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        Publishing Electronic Portfolios using Adobe Acrobat 5.0
    

    
        
        Step-by-Step Publishing Electronic Portfolios using Adobe Acrobat 5.0 2002, Helen C. Barrett Here is the process we will use to publish a digital portfolio using Adobe Acrobat. The portfolio will include    
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        Office 2010: Transition from Office Contents. Moving to Microsoft Office Microsoft Office 2010 Project Transition from Office 2003
    

    
        
        Office 2010: Transition from Office 2003 Contents Office 2010: Transition from Office 2003... 1 Moving to Microsoft Office 2010... 1 Universal Features... 2 KeyTips... 2 Backstage View... 2 Quick Access    
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        Skills Exam Objective Objective Number
    

    
        
        Overview 1 LESSON SKILL MATRIX Skills Exam Objective Objective Number Starting Excel Create a workbook. 1.1.1 Working in the Excel Window Customize the Quick Access Toolbar. 1.4.3 Changing Workbook and    
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        CPM-200 User Guide For Lighthouse for MAX
    

    
        
        CPM-200 User Guide For Lighthouse for MAX Contents Page Number Opening the software 2 Altering the page size & Orientation 3-4 Inserting Text 5 Editing Text 6 Inserting Graphics 7-8 Changing the Colour    

    
        More information 
    




    
        Microsoft Excel 2010 Part 2: Intermediate Excel
    

    
        
        CALIFORNIA STATE UNIVERSITY, LOS ANGELES INFORMATION TECHNOLOGY SERVICES Microsoft Excel 2010 Part 2: Intermediate Excel Spring 2014, Version 1.0 Table of Contents Introduction...3 Working with Rows and    
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        Microsoft Office Training Skills 2010
    

    
        
        Lesson 3 - Creating Documents with MS word 2010 Introduction to Word Processing MS-Word 2010 is word processing application that is used create and edit documents such as: Books, letters, reports, newsletters,    
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        Microsoft Word Tutorial
    

    
        
        Microsoft Word Tutorial 1 GETTING STARTED Microsoft Word is one of the most popular word processing programs supported by both Mac and PC platforms. Microsoft Word can be used to create documents, brochures,    
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        Open. Select the database and click. Print. Set printing options using the dropdown menus, then click the
    

    
        
        The Original Quick Reference Guides Microsoft Access 2010 Access is a tool for creating and managing databases collections of related records structured in an easily accessible format such as a table,    
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        Creating a Mail Merge Document
    

    
        
        Creating a Mail Merge Document 1. Set up your Data in an Excel spreadsheet Each column should represent a particular category of information to be included in the Mail Merge. In this example the First    
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        Managing Document Properties
    

    
        
        PROCEDURES LESSON 20: CHANGING CASE AND MANAGING DOCUMENT PROPERTIES Using Uppercase Mode 1 Press the Caps Lock key 2 Type the desired text in all caps Showing Caps Lock on the Status Bar 1 Right-click    

    
        More information 
    




    
        What will I learn today?
    

    
        
        What will I learn today? What s New My Old Adobe did it this way Navigation Pane Tools Pane Comments Pane Share Pane Using Action Wizard Comparing PDF Documents Insert Pages Delete Pages Replace Pages    
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        Office 2007 Overview
    

    
        
        Kent School District Office 2007 Overview Office Button Quick Access Toolbar The Ribbon and Tabs Mini Toolbar Other Office Applications Resources 1 P a g e Created by G. Kinkade, CTE; adapted by G. Whiteman,    
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        PowerPoint Launching PowerPointX
    

    
        
        PowerPoint 2004 Launching PowerPointX 1. Start PowerPoint by clicking on the PowerPoint icon in the dock or finding it in the hard drive in the Applications folder under Microsoft Office 2004. PowerPoint    
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        PDFelement 6 Solutions Comparison
    

    
        
        duct Data Sheet Solutions Comparison Our latest release comes stacked with all the productivity-enhancing functionality you ve come to know and love. Compatibility DC Compatible with Microsoft Windows    
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        Lesson 21 Getting Started with PowerPoint Essentials
    

    
        
        Getting Started with PowerPoint Essentials Computer Literacy BASICS: A Comprehensive Guide to IC 3, 4 th Edition 1 Objectives Identify the parts of the PowerPoint screen and navigate through a presentation.    
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        These pages will help you get started with the Mazda Web Report System. Use the following options to find the information you need:
    

    
        
        Overview The Web Report System is used to display, print and download Mazda reports. All reports that were previously available through the MDCS Report Distribution System (RDS) are now available through    
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        Microsoft Word. Introduction
    

    
        
        Microsoft Word Introduction Microsoft Word is the word processing component of the Microsoft Office Suite. It is used primarily to enter, edit, format, save, retrieve and print documents. The area outlined    
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        More Skills 11 Format and Position Report Controls
    

    
        
        = CHAPTER 5 Access More Skills 11 Format and Position Report Controls Controls can be aligned using buttons on the Ribbon. Using the Ribbon s alignment tools can be quicker and more accurate than positioning    
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        Software User's Guide
    

    
        
        Software User's Guide The contents of this guide and the specifications of this product are subject to change without notice. Brother reserves the right to make changes without notice in the specifications    
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        Microsoft Office Word 2010
    

    
        
        A Microsoft Office Word 2010 Selected Element K courseware addresses Microsoft Office Specialist (MOS) and MOS Expert certification skills for Microsoft Word 2010. The following table indicates where Word    
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        Appendix A Microsoft Office Specialist exam objectives
    

    
        
        A 1 Appendix A Microsoft Office Specialist exam objectives This appendix covers these additional topics: A Word 2010 Specialist exam objectives, with references to corresponding coverage in ILT Series    
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        Quick Start Guide - Contents. Opening Word Locating Big Lottery Fund Templates The Word 2013 Screen... 3
    

    
        
        Quick Start Guide - Contents Opening Word... 1 Locating Big Lottery Fund Templates... 2 The Word 2013 Screen... 3 Things You Might Be Looking For... 4 What s New On The Ribbon... 5 The Quick Access Toolbar...    
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        Using Word 2016: A Quick Guide
    

    
        
        Using Word 2016: A Quick Guide Prepared by Sali Kaceli http://kaceli.com GETTING STARTED WITH WORD 2016 CREATING A NEW DOCUMENT & THE DOCUMENT GALLERY 1. Open Word 2016 2. Click on Blank Document or click    
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        When you pass Exam : Access 2010, you complete the requirements for the Microsoft Office Specialist (MOS) - Access 2010 certification.
    

    
        
        Appendix 1 Microsoft Office Specialist: Access Certification Introduction The candidates for Microsoft Office Specialist certification should have core-level knowledge of Microsoft Office Access 2010.    
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        QuickStart Guide MindManager 7 MAC
    

    
        
        QuickStart Guide MindManager 7 MAC Contents Welcome to Mindjet MindManager...... 1 Technical Support and Registration... 1 About this User Guide............... 1 Learn about MindManager and maps... 2 What    
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        COMPUTERIZED OFFICE SUPPORT PROGRAM
    

    
        
        NH113 PowerPoint Level 1 16 Total Hours COURSE TITLE: PowerPoint Level 1 COURSE OVERVIEW: This course provides students with the knowledge and skills to create and deliver engaging multimedia presentations    
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        Introduction to Microsoft Office PowerPoint 2010
    

    
        
        Introduction to Microsoft Office PowerPoint 2010  TABLE OF CONTENTS Open PowerPoint 2010... 1 About the Editing Screen... 1 Create a Title Slide... 6 Save Your Presentation... 6 Create a New Slide... 7    
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        Map Direct Lite. Contents. Quick Start Guide: Sharing the Map 9/4/2015
    

    
        
        Map Direct Lite Quick Start Guide: Sharing the Map 9/4/2015 Contents Quick Start Guide: Sharing the Map... 1 Sharing Maps and Data in Map Direct Lite.... 2 Print Your Map to PDF.... 3 Share Your Map by    
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        OnBase - EDM Services (Electronic Document Management Services)
    

    
        
        OnBase - EDM Services (Electronic Document Management Services) Overview EDM Services contains the following features: EDM Briefcase Prerequisites The EDM Briefcase allows you to: Document Templates Image    

    
        More information 
    




    
        Layers. About PDF layers. Show or hide layers
    

    
        
        1 Layers About PDF layers You can view, navigate, and print layered content in PDFs created from applications such as InDesign, AutoCAD, and Visio. You can control the display of layers using the default    
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        MICROSOFT WORD. MS. Office includes the following application:
    

    
        
        MICROSOFT WORD MS. Office consists of group of application developed overtime by MS work together, both in terms of accomplishing things is a similar way and in terms of providing easy of data. MS. Office    
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        Switchboard. Creating and Running a Navigation Form
    

    
        
        Switchboard A Switchboard is a type of form that displays a menu of items that a user can click on to launch data entry forms, reports, queries and other actions in the database. A switchboard is typically    
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        BusinessObjects Frequently Asked Questions
    

    
        
        BusinessObjects Frequently Asked Questions Contents Is there a quick way of printing together several reports from the same document?... 2 Is there a way of controlling the text wrap of a cell?... 2 How    
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        Acrobat 6.0 Standard - Basic Tasks
    

    
        
        Converting Office Documents to PDF 1. Create and edit document in Office application (Word, Excel, PowerPoint) 2. Click the Convert to PDF button on the Acrobat toolbar If the buttons are not visible,    
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        Our Goals Teaching with Power Point
    

    
        
        Our Goals Teaching with Power Point October 14, 2003 Create a new presentation. Add text, graphics,charts, and tables. Apply transitions. Insert hyperlinks such as: http://www.hamline.edu Goals Continued    
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        MICROSOFT WORD 2010 Quick Reference Guide
    

    
        
        MICROSOFT WORD 2010 Quick Reference Guide Word Processing What is Word Processing? How is Word 2010 different from previous versions? Using a computer program, such as Microsoft Word, to create and edit    
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        Microsoft PowerPoint 2016 Basics Unit 9 Final Review - Student Notes Directions: Fill in the blanks.
    

    
        
        Directions: Fill in the blanks. 1. PowerPoint Window Layout 2. File Tab When clicked, opens - automatically opens the Info option by default Holds the following options: - Info - New - Open - Save - Save    
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        Adobe Acrobat Reader 4.05
    

    
        
        Adobe Acrobat Reader 4.05 1. Installing Adobe Acrobat Reader 4.05 If you already have Adobe Acrobat Reader installed on your computer, please ensure that it is version 4.05 and that it is Adobe Acrobat    
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        Word Processing vs. Desktop Publishing
    

    
        
        Automating Microsoft Word 2003 1 Course Topics: I. MS Word Overview II. Using Styles III. Using Templates IV. Running and Recording a Macro Microsoft Word Review Word Processing vs. Desktop Publishing    
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        Scan to PC Desktop Professional v9 vs. Scan to PC Desktop SE v9 + SE
    

    
        
        Scan to PC Desktop Professional v9 PaperPort Desktop Page Thumbnails on the Desktop for Image and PDF files T (Scanner Enhancement) Tools on the Desktop Search by Document Name and Metadata PageViewer    
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        Microsoft Office Word 2010
    

    
        
        Microsoft Office Word 2010 Content Microsoft Office... 0 A. Word Basics... 4 1.Getting Started with Word... 4 Introduction... 4 Getting to know Word 2010... 4 The Ribbon... 4 Backstage view... 7 The Quick    
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        Boxoft PDF Stamper does NOT require Adobe Acrobat, and produces documents compatible with Adobe Acrobat Reader Version 5 and above.
    

    
        
        Note: This product is distributed on a try-before-you-buy basis. All features described in this documentation are enabled. The registered version does not insert a watermark in your generated pdf documents.    
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        Creating A Presentation in PowerPoint 2013 Objectives Define presentation software Plan an effective presentation Examine the PowerPoint window Enter slide text 2 Objectives Add a new slide Apply a design    
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        Concordance Basics Part I 1  Getting Started 1 Familiarity with the Concordance environment is the first step in learning the multi-faceted features of this powerful program. This chapter focuses on learning    
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        Microsoft Office Excel 2007: Basic Course 01 - Getting Started Slide 1 Getting started Course objectives Identify spreadsheet components Identify the main components of Excel Use the Help feature Open    
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        Creating Mailing Labels (2010) The procedure through to printing is a two-stage process. Firstly the client list for the mailing labels is created in Query Builder and then the information is merged within    
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        More information 
    




    
        Complete Quick Reference Summary
    

    
        
        Microsoft Access 2010 Complete Quick Reference Summary Microsoft Access 2010 Quick Reference Summary Advanced Filter/Sort, Use AC 153 Advanced button (Home tab Sort & Filter, Advanced Filter/Sort) All    
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        Vendor: Microsoft Exam Code: 77-887 Exam Name: MOS: Microsoft Office Word 2010 Expert Version: DEMO QUESTION 1 Arrange the steps to add a Style to the Quick Styles gallery in the correct order. Answer:    
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        CHAPTER 1 Working with Excel You use Microsoft Excel to create spreadsheets, which are documents that enable you to manipulate numbers and formulas to quickly create powerful mathematical, financial, and    

    
        More information 
    




    
        Office 2010: New Features Course 01 - The Office 2010 Interface
    

    
        
        Office 2010: New Features Course 01 - The Office 2010 Interface Slide 1 The Excel Ribbon (Home Tab) Slide 2 The Cell Styles Gallery in Excel Slide 3 Live Preview Default Live Preview of the cell style    
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        BAKERSFIELD COLLEGE WEB GUIDE Accessible Formatting for MS Word Version 1.0 User Level: Faculty/Staff Introduction Bakersfield College promises our students to use accessible documents and materials for    
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        Accessing Web Version of Life Illustrator After signing into the Nationwide Financial Sales and Service Center website, the web version of Life Illustrator can be accessed by clicking on Products>Life>Resources>Tools>Nationwide    
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        Microsoft Powerpoint 2013 Lesson 4 Designing a Presentation 2014, John Wiley & Sons, Inc. Microsoft Official Academic Course, Microsoft Word 2013 1 Objectives 2014, John Wiley & Sons, Inc. Microsoft Official    
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